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What is Office Toys 97?
Office Toys is the world’s first add-on for Microsoft Word 97, created by the author of the award 
winning add-ons MegaWord, Office Navigator and WordToys for previous versions of Word. We’re 
committed to continuously expanding and improving Office Toys. New versions can be downloaded at
any time from CompuServe GO WINSHARE Library 6, or from our Web site 
http://www.officetoys.com/. See the README.TXT file for any additional download locations.

Installing Office Toys 97
When you ran the Office Toys Setup program, all required files should have been copied to their right 
locations. If somehow Setup failed, you can copy the files manually.
Office Toys for Word 97 consists of the following files, which must be installed properly.
The OFFTOY97.DOT file is an add-in template, which must be copied to the Office Startup folder 
(typically C:\Program Files\Microsoft Office\Office\Startup). Once copied to this folder (or the 
equivalent folder if you’re running a non-English version of Word), all Office Toys applications are 
immediately available.
The OFFTOY.DLL file, must be copied to the folder where WINWORD.EXE is located (typically C:\
Program Files\Microsoft Office\Office\). If you encounter any problems when running Office Toys 
chances are that Word cannot find the OFFTOY.DLL file. 
See the README.TXT file for any additional installation instructions.

Uninstalling Office Toys 97
To uninstall Office Toys, open the TOYSETUP.DOC file in the Toys subfolder of your main Office folder 
(typically C:\Program Files\Microsoft Office\Office\Toys), and follow the online instructions. 

Don’t forget the Office Assistant
All Office Toys wizards, and also some other Office Toys applications require that the Office Assistant
is installed. If you didn’t install the Assistant, run the Office setup program again, and install the 
Assistant before you use Office Toys.

Office Toys is not free software!

This package is distributed as shareware, which allows you to try its features for a limited period of six
weeks without paying anything. Unlike other add-ins, the trial version of Office Toys is not crippled in 
any way; every single feature works without any restrictions. 

If you like Office Toys, and you want to continue using it, you are expected to register your copy. 
During the first 15 days after installation you will only see a single registration reminder each time you
start Word. Between day 15 and day 42 the reminder pops up every hour. If you haven’t registered 
your copy within 42 days (6 weeks) after the installation, Office Toys will automatically disable 
itself. 

How do register my copy?

It’s cheap and easy to become a “legal” Office Toys user. The registration price is just $39.95.  If 
you’re a registered user of one of our previous add-ins for Word (MegaWord, Office Navigator or 
WordToys), you pay just $24.95. Once you’re registered, all future Office Toys upgrades for Word 97 
will be FREE.  Upon registration you will receive a unique User ID via email. This User ID consists of 
two letters, followed by six digits.

To register your copy of Office Toys, choose “About Office Toys” from the Toys menu, and type your 
name and User ID exactly as you received them from us. If the combination of username and ID is 
valid, the nag screens will disappear forever.
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How do I get my User ID?
There are a several ways to register your copy. Whichever way you choose to pay, you will always 
receive your User ID directly from Merlot International, by email, fax or letter

Via CompuServe
If you’re a CompuServe member, GO SWREG, and look for registration ID 15003. If you’re a 
registered user of one of our previous Word add-ins, you can upgrade for $24.95 via SWREG ID 
15004. Your registration fee will be included in your monthly CompuServe bill.

By Eurocheque or French bank check
If you live in Europe, you can pay by Eurocheque or French chèque bancaire. The equivalent 
European registration fee is BPF 240 (that’s 240 French francs). If you qualify for the upgrade price, 
the amount is BPF 150. Please send your cheque to:
Merlot International
Romke Soldaat
1 chemin des Moulines
34230 St. Bauzille de la Sylve
FRANCE

Via Public (Software) Library
We offer secure credit card ordering over the Internet via PSL (Public Software Library) in Houston. 
Please point your web browser to http://www.officetoys.com/order.htm for details. Online ordering is 
available for customers in any part of the world.

Via Baarns Publishing
Our American partner Baarns Publishing accepts MC, Visa, AmEx, Discover, Check or Money 
Orders. You can contact them at:
Baarns Publishing
11150 Sepulveda Blvd.
Suite D
Mission Hills, CA 91345
phone 800.377.9235 or Outside U.S. 818.837.1441
Fax 818.837.1445
Web site http://www.baarns.com 

Office Toys now also available in German!
We’re proud to be the first on the planet with a German add-on for Word 97. To find out more, look at 
the web site of our German partner SmartTools: http://www.add-in-world.com/katalog/officetoys97 

More sensational Toys to come!
Office Toys is not a static package. Over time we’re likely to add new features and improve the 
current ones. Besides, we’d like to hear what you want. If your ideas are viable, and if we believe 
there’s a market for them, we’ll add them to Office Toys. Send your ideas to 
suggestions@officetoys.com.

Look out for Office Toys for other Microsoft Office applications!
Some of the Office Toys applications, such as the Office Navigator, will probably be ported to other 
applications in the Microsoft Office suite. Stay tuned to http://  www.officetoys.com  /   for the latest 
upgrade news!
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For all additional information, please contact:
Merlot International
Romke Soldaat
1 chemin des Moulines
34230 St. Bauzille de la Sylve
FRANCE
Tel: (+33) (0) 4.67.57.55.88
Fax: (+33) (0) 4.67.57.20.87
CompuServe: 100273,32
Internet: romke@officetoys.com and romke@msn.com
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What happens on my screen after I’ve installed Office Toys?
If the Office Toys components are correctly installed, your Word screen will look different. The most 
obvious changes are:
 the Navigator menu between the File and Edit menu, 
 the Toys menu between the Window and Help menu, 
 the Print to button on the Standard toolbar, and 
 the Style button at the left of the Formatting toolbar. 
There’s also a small Office Toys toolbar. If this toolbar isn’t visible, choose View, Toolbars, and 
select Office Toys in the list. 
We’ve tried hard to reduce screen clutter to its absolute minimum, so instead of adding dozens of 
buttons to the Office Toys toolbar, we’ve placed most of them on the Toys menu. In addition, we’ve 
modified and added a number of options on most of Word’s own menus.

What else does Office Toys do on my system?
Once you start using Office Toys, the following folders are automatically created on your system.
 Toys. A subfolder of your main Office folder. The Setup program creates this folder as the “home”

of all Office Toys documentation files, and also places a number of subfolders in this folder.
 Recent. A subfolder of the Toys folder. Office Navigator uses this as the location for shortcuts to 

your recently used documents. 
 Essentials. A subfolder of the Toys folder. Office Navigator uses this as the location for shortcuts

to important documents you always want to have available.
 Projects. A subfolder of the Toys folder. Office Navigator uses this as the location for document 

projects, created with the Project Manager.
 Envelopes. A subfolder of the Toys folder. The location where Office Toys stores Envelope 

templates.
 Favorites. A subfolder of your Templates folder. Office Navigator uses this as the location for 

shortcuts to your most used templates.
It is important not to delete or rename these folders. Office Toys needs them for some vital tasks. If 
you delete or rename the Recent, Essentials, Envelopes, Projects, or Favorites folder, it is 
automatically recreated.

Can I customize Office Toys?
Yes, but there’s only one correct way to do this. If you want to move buttons or menus, or delete 
Office Toys items you don’t plan to use,  follow the steps below very carefully, and repeat them each 
time you want to customize Office Toys. If you try to customize Office Toys in any other way, you’re 
likely to loose features, or some menu items may become disabled.
1. Open OFFTOY97.DOT as a normal document. You can find the file in your STARTUP folder.
2. Make sure that OFFTOY97.DOT is the active document during all subsequent steps.
3. Choose Tools/Customize, and leave the dialog box open, during all subsequent steps.  If you like,

you can move the dialog box as far out of the workspace as necessary.
4. To delete a button or menu item, right-click on it, and choose the Delete option. 

To move an item, select it with your mouse and drag it to its new location.
5. When you’re done, close the Customize dialog box.
6. Save OFFTOY97.DOT
7. Close OFFTOY97.DOT

Why do I see the prompt to save changes when I exit Word?
Office Toys is a dynamic template which modifies itself when you use it. If you exit Word by clicking 
on the icon on your Word toolbar, you may be prompted to save changes in OFFTOY97.DOT. You 
can safely answer “No”. To avoid this prompt and exit Word quickly, use the ALT+F4 key combination
instead.
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How do I use the Office Toys?
Office Toys adds an enormous amount of new functionality to Word, so it’ll take you some time to find
all tools and get used to them. The best way to familiarize yourself is by printing this User’s Guide and
walking through it, while Word is open on your screen. In the remainder of this document we’ll go 
through the entire package, and tackle its features by using the following categories:
 Managing your documents: Office Navigator
 Managing your documents: Office Navigator Project Manager
 Managing your documents: Office Navigator Backup
 Managing your documents: AutoPilot
 Managing your documents: User Manager
 Managing your documents: Virus Alert
 Printing and networking
 Formatting: the Style menu
 Formatting: Finetuner and other formatting enhancements
 Selecting and Editing
 Editing: Favorite Symbols & Bullets
 Proofing
 Finding and Navigating 
 Viewing and organizing windows
 Managing information
 Customizing Word
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Managing your documents: 
the Office Navigator

Office Toys comes with a host of features that make it easy to manage your documents and 
templates. Most options are conveniently grouped together in the Navigator menu, between the File 
and Edit menu. 

Managing your documents with the Office Navigator
Office Navigator 97 for Word 8 is the sequel to the acclaimed Office Navigator package for previous 
versions of Word. All features of this comprehensive file management suite are combined in a single 
Navigator menu. If you know how to navigate through the Windows Start menu, you will be instantly 
familiar with the Office Navigator. Whichever file, template, project or folder you want to use, it’s never
more than one mouse move away!

How is the Navigator menu organized?
The Navigator menu consists of five groups, each with one or more options or submenus. The tasks 
on the menu are organized as follows:
Group 1: Create a new document, and organize your favorite templates
Group 2: Open a document, and organize your favorite folders
Group 3: Open a project, save a session
Group 4: Work with the current document
Group 5: Miscellaneous actions
Group 6: Customizing Navigator

Group 1: Create a new document, and organize your favorite templates 
The first group on the Navigator menu streamlines the creation of new documents. 

“Favorite Templates” menu

Why “Favorite Templates”?
If you use only a hand full of templates on a regular basis, you’re probably not really interested in 
seeing all templates in Word’s multi-tabbed “New” dialog box. With the Office Navigator you can now 
easily create your shortlist of Favorite Templates, and quickly pick your template from the menu. 

Creating Favorite Templates
To add a template to the list, choose “Add Favorite template”. This opens Word’s “New” dialog box. 
Select a template and click OK. From now on the template is on your list of Favorites, and you can 
select it from the menu.

Automatically creating Favorite Templates
You can also automate the process of creating favorite templates. Choose “Navigator Setup” and 
check the first box on the “Auto-Favorites” tab. When enabled, Office Navigator automatically adds 
each new template you use to your list of favorites.

Where are the Favorite Templates stored?
When you assign favorite templates, Office Navigator adds shortcuts to these templates in a special 
“Favorites” subfolder of the Office Templates folder. The Favorites folder appears as a tab with the 
same name in Word’s “New” dialog box.
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Removing Favorite Templates
To remove a favorite template from the Navigator menu, hold down the SHIFT key and select the 
template you want to remove. This deletes the shortcut in the “Favorites” folder, but leaves the 
original template untouched.
To delete multiple Favorite templates, you can run the Windows Explorer, and browse to the 
Favorites folder under your main Templates folder. Select the shortcut files that represent the 
templates you want to delete and press the DEL key.

“Wizards” menu
This menu lists all wizards installed on your system. A wizards is a special type of template that helps
you to create a special type of document (e.g. a web page, a memo or a mailing label), or to 
manipulate the document you’re working on.

“All Templates” menu
This menu gives you ultra fast access to all your templates. It expands to an alphabetically sorted list 
of your template categories and the templates and wizards they hold. You’ll never go back to Word’s 
“New” dialog box!

How Office Navigator handles workgroup templates
If your system is set up to work with network templates, a separate “Workgroup” menu under the 
“General” menu holds all your network templates. This is a vast improvement over Word’s way of 
adding all workgroup templates to the “General” tab of the “New” dialog box.

Basing a new document on any file 
It’s a largely unknown fact that Word can also use regular documents as a template. Word’s “New” 
dialog box doesn’t let you do that, but Office Navigator does. Choose “Explore” to display a dialog box
from where you can select any file, anywhere on your computer or on the network, on which you want
to base a new document. 

Opening a template for editing 
Choose “Edit Template” to display a dialog box from where you can open a template as a document. 
You can then edit the template and save it. 

Group 2: Open a document, and organize your favorite folders
The second group on the Navigator menu helps you find and open recent, favorite or essential 
documents, and organize them in “favorite folders”. Each menu in this group represents a folder, and 
lists all Word documents in that folder. Once you’ve set up these menus, you can find and open any 
file in a single mouse action!

“Recent documents” menu
This menu opens a list of all your recent documents. Office Navigator automatically updates this list, 
by creating shortcuts to your documents in a special “Recent” folder in the “Toys” folder. Unlike 
Word’s history list on the File menu, the storage capacity of the Office Navigator recent files list is 
only limited by your available disk space.

Opening a recent document
To open a document on the menu, simply select it. The menu displays documents in their short form, 
without the pathname. If you want to see the full pathnames of files, hold down the CTRL key while you
open the “Recent documents” menu.

Removing recent documents
You can at any time clear entries from the list, using one of two methods. 
To remove a single entry, hold down the SHIFT key and select the document you want to remove. This
deletes the shortcut in the “Recent” folder, but leaves the original document untouched. 
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To delete more than one file from the history list, select “Explore”. This displays Word’s “Open” dialog 
box with all file shortcuts in the “Recent” folder. Hold down the CTRL key and select each shortcut you 
want to delete, then press the DELETE key.

“Working folder” menu
This menu lists all Word documents in the current user’s main document folder. Since Office 
Navigator offers the option to assign different working folders to different users (see later in this 
document), the current user name also appears on the menu.

“Active folder” menu
This menu lists all Word documents in the same folder as the document you’re working on, so you 
can quickly open other documents from the same location. If no documents are open, or if the current
document hasn’t been saved yet, the current folder is listed instead.

“Favorite folders” menu
This is a fully configurable menu, in which you can place folders that hold documents you’re likely to 
open often. Selecting a folder on the menu immediately lists all Word documents in that folder. You’ll 
never browse through Word’s “Open” dialog box again! 

Creating Favorite folders
Initially, Office Navigator adds a number of default Windows folders to this menu. To add other 
entries, select “Add favorite folder…” and follow the instructions. 
You can also automate the process of creating favorite folders. Choose “Navigator Setup” and check 
the second box on the “Auto-Favorites” tab. When enabled, Office Navigator automatically adds each 
folder from which you open a document to your list of favorites. 

Removing Favorite folders
To remove a favorite folder, open the associated menu and select the “Remove” option at the bottom 
of the list. This does not delete any files or folders, it only removes the folder from the list

“Essentials” menu
This is a special menu, designed to hold documents that you need practically every day (or at least 
for an extended period), and that you want to open without wasting time. Office Navigator stores 
shortcuts to your these documents in a special “Essentials” folder in the “Toys” folder. Select “Add to 
Essentials” to add the current or a different document to this menu.

Removing documents from the “Essentials” menu
To delete a document from the “Essentials” list, select “Explore Essentials”. This displays Word’s 
“Open” dialog box with all files in the “Essentials” folder. Hold down the CTRL key and select each 
shortcut you want to delete, then press the DELETE key.

“My Computer” menu
This menu lets you browse through all drives of your computer, starting from the root. Just hold your 
mouse button down while you select folder, until you’ve reached the document you want to open. 

Group 3: Work with Sessions and Projects
Many years ago we introduced the concept of document projects in our MegaWord and Office 
Navigator add-ons. In the third group of the Navigator menu we make it even easier to manage 
groups of related documents. See “Managing your documents: Office Navigator Project Manager” for 
more about creating and managing projects and sessions.

Office Toys for Word 97. ©1996/97 Romke Soldaat. All Rights Reserved - Page 10 of 43 - Printed 4/13/1997 11:43:00 AM



“Session” menu
Office Navigator lets you quickly save and recreate sessions. When you save a session, Office 
Navigator creates a project file which holds the names of all documents that are currently open in 
Word. To recreate a session, you can simply point to the project file, and Office Navigator 
automatically reopens all documents for you.

Open Last Session
With this option you can quickly recreate the project that was stored under the special name “last 
Session”. If no session was saved under that name, this option is unavailable.

Save Current Session As
Select this option to create a session project which holds all documents that are currently open in 
Word. (Note: unsaved documents are not included in a project.) The default name for the session 
project is “Session”, followed by a date and time code, but you can change that name if you like. 
Make sure to use only characters that are valid in filenames, so avoid using these illegal characters:  /
\ : * ? " . < > |. 

Auto-Session Options
This displays the Auto-Session tab of the Office Toys Project Manager dialog box. Here you can set 
preferences for automatically saving and restoring sessions. 

“Projects” menu
On this menu you can recreate any of your projects and sessions. The project you created or opened 
last is selected as the default. Select “Explore Projects” to display Word’s “Open” dialog box, with all 
project files selected. To delete or rename projects, use the standard options available in the dialog 
box.

“Project Manager”
This displays the Office Toys Project Manager dialog box, which is described in detail in the section 
“Managing your documents: Office Navigator Project Manager”

Group 4: Work with the current document
The fourth group on the Navigator menu offers many options to work with the current document. Most
of these tasks cannot be found on Word’s File menu. Some options are only available if the document
has been saved.

“Manipulate” menu
This menu lists file actions that let you modify the name, location, or appearance of the current 
document. 

Save in
Use this option if you want to save a file for the first time, without browsing, or if you want to copy the 
document to a different folder, optionally with a different name. The list holds your favorite folders (if 
you have defined any in the “Favorite Folders” menu), in which you can instantly save the current 
document. When you have selected a folder, the “Save As” dialog box is displayed. 

Move to
This menu opens a list of your favorite folders (if you have defined any in the “Favorite Folders” 
menu), to which you can move the current document. When you have selected a destination folder, 
the “Save As” dialog box is displayed. If the file has been successfully saved, you will be asked if you 
want to delete the original document. In some circumstances it is not possible to delete the original 
document. If that’s the case Office Navigator will tell you that you have to delete the original file 
manually.
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Save as
This is Word’s original Save As command. You can use it to save a new document for the first time, 
or create a copy under a different name, with a different format and/or in a different folder.

Convert to…
This option lets you instantly convert the active document into any document format for which you 
have converters installed. Office Toys saves the document with its original name and extension, 
effectively replacing the document on your disk. If you want to keep a copy of the original document 
use the “Save as” command instead. Remember that converting a document from one format to 
another may cause a loss of content or formatting, so you are prompted to confirm the action. Also 
note that Word doesn’t let you convert a template into a different document format. 

Rename
Lets you change the name of the current document. The document is saved under its new name in 
the same folder, and the original document is deleted. If a document with the new name already 
exists, you are prompted to type a different name. In some circumstances it is not possible to delete 
the original document. If that’s the case Office Navigator will tell you that you have to delete the 
original file manually.

Delete
Closes the document without saving recent changes. You are prompted to confirm the action. If the 
document has been saved before, it is deleted. In some circumstances it is not possible to delete the 
document. If that’s the case Office Navigator will tell you that you have to delete the original file 
manually.

Attach Template…
Lets you attach a different template to the current document. This option is not available if the current 
document is a template itself.

“Versions” menu
Word 97 offers the exciting option to save different versions of a document in the same file. You can 
add comments to each version, and reopen or delete earlier versions. Office Toys adds a number of 
related features, and makes it easier to create new versions or open existing versions. 

Open version
If you have created multiple versions of the current document, this menu lists all of them. Depending 
on the available space on the menu, each version is listed with its date, comment, and the name of 
the comment’s author. Select the item to open the associated version.

Save version
Select this option to save a new version of the current document. You are prompted to write a 
comment on the new version.

Versions…
This displays Word’s standard Versions dialog box, in which you can review comments, delete 
versions, or add a new version.

Highlight unsaved changes
This option compares the active document with the version you saved last, and highlights the 
differences. You can then right-click on the highlighted parts and accept  or reject the changes. This 
option is only available if the document has been saved before.

Revert to last saved version
This option lets you undo all changes you have made in the document since the last time it was 
saved. You are prompted to confirm this action. This option is only available if the document has been
saved before.
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Compare documents…
Lets you compare the current document with any other document on your system, and highlights the 
differences. You can then right-click on the highlighted parts and accept  or reject the changes. 

Duplicate
This creates an exact copy of the current document, and makes the copy active, allowing you to work 
on the copy without making changes in the original. You can then decide which of the two versions 
you want to keep. This option is only available if the document has been saved before.

“Add shortcut to…” menu
This opens a list of four common destinations where you can place a shortcut to the current 
document. Once you have created a shortcut, you can simply click it to open the associated 
document in Word. Select “Other folder” if you want to create a shortcut in a different folder.

“Backup to…” menu
This opens a list of destinations to which you can create a backup of the active document. Select 
“Backup Settings” to specify these destinations and other preferences. All Backup features are 
described in the section “Managing your documents: Office Navigator Backup”.

“AutoPilot”
This option starts the Office Toys AutoPilot application. In the AutoPilot dialog box you can select up 
to 21 file commands, and execute them in an automatic batch process. AutoPilot is described in detail
in the next section “Managing your documents: AutoPilot”.

Group 5: Miscellaneous actions
The fifth group on the Navigator menu offers a number of additional options.

“Create folder under…” menu
This feature lets you quickly create subfolders of existing folders, an option that Microsoft left out of 
the “Open” dialog box in Word 97. The menu lists the active folder of the current document, plus all 
your favorite folders (if you have defined any in the “Favorite Folders” menu). To create a new 
subfolder under a different folder, select “Other folder” and follow the instructions.

“Change user” menu
With this option you can activate a different user of your copy of Word. The menu lists all users you 
have defined in the Office Toys “Tweak Word” application. Selecting a user immediately activates the 
associated working folder, updates the user information (name, initials, and address), and displays 
the user’s name on the Navigator menu.
To add new users, or modify current user settings, select “Edit user list”. This starts the Office 
Navigator “Tweak Word” application which lets you add or remove users from the list.
See “Managing your documents: User Manager” for a full description of this feature.

Group 6: Navigator Setup
The are many ways to modify the behavior of the Office Navigator. Select “Navigator Setup” to get 
access to the following options:

Automatically add each Template I use to the Favorite Templates menu
If enabled, Office Navigator adds each template you use to the menu of Favorite Templates, and to 
the Favorites tab of Word’s “New” dialog box. The default is “off”.

Automatically add each Folder I access to the Favorite Folders menu
If enabled, Office Navigator adds each folder from which you open a document to the menu of 
Favorite Folders. The default is “off”.

Office Toys for Word 97. ©1996/97 Romke Soldaat. All Rights Reserved - Page 13 of 43 - Printed 4/13/1997 11:43:00 AM



Show subfolders in Navigator file lists
If enabled, Office Navigator shows the names of subfolders in each file list, allowing you to browse 
“deeper” into the folder tree, and open files from subfolders. The default is “on”. You may want to 
disable this feature if you work on a computer with a low-resolution screen. 

Show full pathnames in Navigator file lists
By default, Office Navigator displays only the name of the file in the file lists, without any path 
information. Check this box if you’d rather see the full pathnames. The default is “off”.

Use the following filters to create the file lists
The two textboxes hold the search criteria Office Navigator uses when it creates the document and 
template lists on the Navigator menu. Normally you don’t have to modify these criteria, because they 
are the same ones that Word uses, and Office Navigator updates the list automatically each time you 
open a file with a new extension. If you want to modify the list of file types, make sure to use the 
format *.EXT, and use semicolons (;) to separate the file types. To restore the original settings, leave 
the textbox blank and press OK.
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Managing your documents:
Office Navigator Project Manager

About Project Manager
Office Navigator Project Manager brings the concept of document projects to Microsoft Office. If you 
often work on a number of related documents at the same time (book chapters, mail merge 
documents, forms, spreadsheets, databases, etc.), you can now open them with a single command. 
A project can consist of any number of documents (both Word documents and files created with other
applications, such as Excel, Access, etc.), scattered over any number of folders or network paths. 
Project Manager can also quickly save your current Word session as a project, and restart your next 
session with the same documents. There’s even an option to save and restore Word sessions 
automatically. 

Default settings
Project Manager creates its project files in a ”Projects” subfolder of the “Toys” folder. Project files are 
small text files, with the extension “.PRO”. For example, a project with the name “My Word 97 Book” is 
stored under the name “MY WORD 97 BOOK.PRO”. It is not recommended to make any manual changes
to these documents.

Running Project Manager
To open the Project Manager dialog box, choose Project Manager from the Navigator or Toys 
menu. All options are available on three tabs.

“Open Project” tab
On this tab, select a project to display a list of all files that are part of that project. By default, all files 
in the project are selected, but you can use your mouse to select or deselect any file. Click the “Select
all” box to select or deselect all files. 

“Open Project Files” button
Click this button to open all selected files. If files are recognized as Word documents, they are 
opened in Word, otherwise Project Manager will open the file in the application that’s associated with 
it. E.g. a spreadsheet is opened in Excel, and a bitmap is opened in Paint. If a project holds 
executable files, Project Manager starts that application.

“Print Project Files” button
Click this button to print all selected files. If files are recognized as Word documents, they are printed 
(but not opened) by Word, otherwise Project Manager will print the file via the application that’s 
associated with it. E.g. a spreadsheet is printed by Excel, and a bitmap is printed by Paint. If a project
holds executable files, Project Manager starts that application rather than prints it.

“Rename Project“ button
Click this button to rename the selected project. The following characters cannot be used: < > : ” / \ |.
If a project with the same name exists, you are prompted to confirm the operation.

“Delete Project” button
Click this button to delete the selected project. This only deletes the project file itself; the documents 
that are included in the project are not deleted.

“Create/Edit Project” tab
On this tab you can define new projects, or add or remove files to an existing project. 
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Creating a new project
To create a new project, select [new project] in the Projects list. This clears the list of files, so you 
can start “filling in” the project. You can also base a new project on an existing project. In that case, 
select the existing project, and add or remove files to it. When you are ready to save the project, you 
can either use the existing name, or specify a new name.

“Add open document” button
Click this button to display a list of documents that are currently open in Word. The list only shows 
documents that have been saved. Select the ones you want to add to the project and click OK.

“Add from disk” button
Click this button to display a browser dialog box in which you can select one or more files you want to
add to the project. You are not limited to Word or even Office documents; you can also add files that 
are used with other applications, such as drawing programs or multimedia players. You can even 
create a “project” of executable files, and start these applications in a batch process, simply by 
opening the project! For example: you can create a project that holds the CALC.EXE file in your 
WINDOWS folder, and start the Windows Calculator by opening the associated project.

“Remove selected item” button
Click this button to delete files from the list. This only removes the filename from the project; the 
document itself is not deleted.

Saving the project
Once you have selected the files you want to include in the project, click the “Save Project As” button.
You are prompted to specify a name. The following characters cannot be used: < > : ” / \ |.

“Auto-Session” tab
On this tab you can select your preferences for the Auto-Session feature. When enabled, Auto-
Session creates a special project under the name “Last Session” when you exit Word, and lets you 
automatically open this project when you start Word. This gives you a convenient way to end a Word 
session and continue to work on the same documents the next time you start Word. To get most 
benefit from this feature, consider the “Always auto-save current session” and “Prompt me to open 
last session” settings as your defaults.

“Save Session As” button
This button is available on all tabs in the Project Manager dialog box. Click it to save your current 
session as a project that you can reopen at a later stage.

Other ways to open a project
 The Navigator menu gives you the fastest access to a project. Simply select a project from the 

“Projects” option to open all documents in that project. 
 Alternatively, you can browse to the Projects folder under the Toys folder and select a file with a

.PRO extension. Office Navigator will then ask you if you want to open all documents in that 
project.
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Managing your documents:
Office Navigator Backup

Backup – at last!
One of the features Word has always missed is a solid backup system. The “Always create backup 
copy” option in the Tools/Options/Save dialog box only creates a copy in the same folder as the 
original document, so in case of a hard disk crash, you still don’t have a backup. Office Navigator 
comes to the rescue with a powerful backup feature that lets you create a copy of the current 
document anywhere on your system or the network. It even lets you add the backup to a compressed
zip file that takes up less disk space, and even fits on a floppy disk.

Setting your backup preferences
To set up Office Navigator Backup, choose “Backup to…” on the Navigator menu, and select “Backup
Settings”. In the dialog box, you can specify one or two different backup folders, and one or two 
backup zip files. Click the Browse buttons to locate these destinations. For the zip file destinations, 
you can specify a non-existent filename, which will be created when you make your first compressed 
backup. However, the pathname must exist. Once selected and confirmed, your backup destinations 
automatically appear under the “Backup to…” option on the Navigator menu.

Backing up to a zip file
Office Navigator can save space (sometimes more than 80%) on your hard disk or floppy by 
compressing the backup into a zip file. This option is only available if you have either Nico Mak’s 
WinZip, or Norton Navigator’s Zip application. If Office Navigator can’t find these applications, the 
“zip” options are unavailable in the Backup Settings dialog box. 
It’s important to know the differences between WinZip and Norton Zip.

Using WinZip
Office Navigator can only interact with the 32-bits (Windows 95 or NT) version of WinZip. Because of 
the nature of WinZip, a compressed backup can only be created when a file is not used by another 
application, so Office Navigator can’t let you add a document to a zip file while it’s open in Word. 
That’s why zip destinations don’t appear on the Navigator menu if WinZip is your compression 
program. You can, however, create compressed backups with WinZip via the Office Navigator “Auto-
Backup” feature (see below).

Using Norton Zip
Norton Zip (part of the Norton Navigator for Windows 95) has an important advantage over WinZip, 
because it can create “hot zips”. This means that you can backup a document to a compressed file 
while you’re working on it. If you have Norton Zip, you will therefore also see your preferred zip 
destinations on the Navigator menu. If you have both WinZip and Norton Zip, it makes sense to select
Norton Zip as your preferred compression program in the Backup Settings dialog box. The drawback 
of using Norton Zip is that the program wants you to confirm the action in case the same document 
already exists in the compressed file.

Auto-Backup
Office Navigator can automatically create a backup of your document when you close it. The 
destination for the automatic backup can be either your primary backup folder or your primary backup
zip file. You can set your Auto-Backup preferences in the Backup Settings dialog box.
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Restoring Backup files
To restore backup files, select “Backup to…” on the Navigator menu, then select “Restore from”. This 
lists your backup folders and backup zip files. If you select a folder from the menu, Office Navigator 
displays Word’s “Open” dialog box in the selected folder, if you select a zip file, Office Navigator 
opens the compressed file in your zip application
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Managing your documents:
AutoPilot

AutoPilot
With the Office Toys AutoPilot application you can select up to 21 file commands, and execute them 
in an automatic batch process. AutoPilot can be started from the Navigator menu and the Office Toys 
toolbar

Most of the AutoPilot command buttons have an additional ? button which lets you customize the 
command. Hold the mouse button on top of a command button to know which setting is currently 
active, and press the ? button to change the setting. Your preferences are automatically stored as the
default. 

Saving AutoPilot settings with the document
You can optionally check the “Save settings with document” box in the AutoPilot dialog box. When 
checked, the selected commands are stored inside the document, and are automatically selected the 
next time you run AutoPilot with the same document.

Shortcuts
1. If you have checked the “Save settings with document” box for a specific document, you can run 

AutoPilot without displaying the dialog box, by holding down the CTRL while you select “AutoPilot” 
in the Navigator menu. 

2. You can also save a subset of AutoPilot commands as your preference for all documents. To 
create your subset, run AutoPilot, and select the command you usually execute (e.g. Save, Print, 
and Close). Then hold down the SHIFT key and click OK. AutoPilot will execute the commands, 
and stores them as your preference. The next time you want to execute the saved commands 
without displaying the AutoPilot dialog box, hold down the SHIFT key while you select “AutoPilot” 
in the Navigator menu.

More document actions: Window Organizer
The Office Toys Windows Organizer application (on the Window menu) offers an additional set of 
file management features, including the option to select any number of open documents, and save, 
print, route, email or close the selected documents in a single command.
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Managing your documents:
User Manager

Office Toys User Manager is created for situations where more than one user works with the same 
copy of Word for Windows. But even if you're the only user, you can now give yourself different 
"aliases" and create different default document and backup folders, different addresses and different 
initials for different activities. User Manager is on the first tab of the “Tweak Word” application, which 
is available on the Toys menu.

Setting up User Information
The first time you run User Manager, the dialog box shows the same name, initials and mailing 
address as Word's built-in User Info dialog box. In addition, the current default documents folder (the 
folder where Word initially opens and saves documents) is displayed. You can define an unlimited 
number of users, and delete users at any time.
 Click Add user if you want to add new users, or create "aliases" for the default user. This 

displays Word's User Info dialog box in which you can specify a name, initials and mailing 
address. Click OK to add the new user to the list of users. 

 If you want each user to open and save documents in a different folder, you can type a folder 
path in the "Default Documents folder" box, or click the button to browse for the folder. 

 Click OK to store the user information and make the selected user the active user.
 To remove a user from the list, first select the user, then click Delete User. After your 

confirmation the user is permanently removed from the list.

Switching User on the fly
Once you have specified the names, initials, addresses and default document folders for each user 
(or each alias for yourself), you can switch from one user to another on the Navigator menu.
The user info and default document path are instantly updated. If you want to create an envelope, the
address of the selected user automatically becomes the default return address.

Suggestions for effective user of User Manager
 User Manager is a handy tool if you share your computer with colleagues in the same office, or 

with your partner (or the kids!) at home. Now you can use different default document folders, and 
create different mailing addresses for each user. 

 If you're the only person who uses Word, you can have one user profile for your private 
documents, and another one for your business documents. 

 If you want to add annotations to a document, using different initials or codes, you can set up 
different user profiles (with different initials) for each of your revision jobs. Just make sure that the
user name is different, e.g. by adding an asterisk or other symbol after the user name.
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Managing your documents:
Virus Alert

How to arm yourself against document viruses
Over the past few years, hundreds of so-called “macro viruses” have been introduced. Most of them 
are harmless, some however are extremely dangerous. Word 97 offers only limited protection against
these viruses. You can enable the “Macro virus protection” and “Prompt to save Normal template” 
options in the Tools/Options dialog box, but there’s no option that lets you eliminate viruses once your
Normal template is infected.
Office Toys gives you two new ways to protect your Normal template against possible macro viruses. 
To activate these features, run the Anti-Virus Wizard from the Toys menu. This wizard guides you 
step-by-step through all options that offer protection against viruses. The following describes the two 
features that Office Toys adds to your protection scheme.

Create a Backup of my Normal template when I start Word
This option lets you automatically create a backup of your Normal template each time you start Word.
With this feature enabled, Office Toys creates a copy of your Normal template with the name 
NORMAL.BAK, followed by a date and time code, e.g. 'NORMAL.BAK 97-03-23-1457'. If you notice 
that your Normal template has been infected, quit Word and open the Windows Explorer to access 
your Templates folder. You can then delete the NORMAL.DOT file and rename the last safe backup 
into NORMAL.DOT. When you start Word again, you’re back in a safe environment.
Note To avoid cluttering your hard disk, you should regularly (e.g. once a week) delete redundant 
backups of your Normal template from your templates folder. 

Monitor changes in the Normal template while I work
This option lets Office Toys continuously monitor changes in your Normal template while you work. 
Some viruses are designed to enter your system silently and infect your Normal template at a given 
date or time, or after you’ve run a specific command. Office Toys checks your Normal template every 
30 seconds and each time you open, activate or close a document. If the number of macros in your 
Normal template has changed, or if a new version of the Normal template has been saved since the 
last check, you will see a warning. If you don’t trust the modification, you can exit Word and restore 
the last backup of the Normal template, as described above.

Maximum security, minimum annoyance
If you hate those reminders and prompts each time you open a document or add macros to your 
Normal template, you should at least consider enabling the Office Toys option that creates a backup 
of NORMAL.DOT. This process takes less than a few seconds at startup, but at least gives you a 
reliable method to clean up your environment if Word has been infected.
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Printing and Networking
Word’s Print features are limited to the Print button on the Standard toolbar and the Print option on 
the File menu. What’s really missing is a quick way to send a document (or part of a document) to 
any selected printer, without opening a dialog box. Office Toys changes that, and also adds two 
Wizards: one that helps you define a print job, and one that takes care of some common network 
tasks.

“Print to” button
The “Print to” button on the Standard toolbar gives you ultra fast point-and-click access to all your 
installed printers (or fax drivers) without displaying any dialog box. Click the button, select a printer 
from the menu, and the print job is done! 
From the same menu you can also quickly print the current page, the selected text, or even all open 
documents to any installed printer. 
The selected printer becomes the default printer for your current Word session, but not for other 
Windows applications. 

Special options
 To make a printer the default printer for all Windows applications, hold down the CTRL key while 

you select the printer. 
 To activate a printer without printing anything, hold down the SHIFT key while you select the 

printer.

Print Wizard
The Office Toys Print Wizard helps you step-by-step to define a print job. It doesn’t offer some of the 
advanced options found in Word’s Print dialog box (such as printing Styles and Document properties),
but it’s friendly enough to prompt you to spell check a document, so you don’t print or fax a letter or 
report that holds spelling or grammar errors. Even if you’re an experienced Word user, you may find 
that you’ll never go back to Word’s Print dialog again! 

Note
You can start the Print Wizard both from the “Print to” button and from the Toys menu.

Network Wizard
This feature lets you quickly make and cancel connections to network drives and network printers. 
You can start the Network Wizard from the Toys menu.

More “Smart” Print Features
Office Toys also adds a lot of IntoyliSense™ to Word’s Print button on the Standard toolbar and the 
Print command on the File menu. To use these features, you must first run the Tweak Word 
application (on the Toys menu). 
Tweak Word offers four ways to customize Word’s printing commands. 

AutoPrint
AutoPrint lets you associate specific document types with a default printer. Office Toys automatically 
activates the selected printer when you print these documents. This is a handy option if you have 
access to different printers with specific features, e.g. an envelope printer. 

AutoFax
AutoFax detects Fax documents and lets you automatically send them to your fax application rather 
than to your printer. Before sending the document to a printer, Office Toys looks at the template 
name, filename and contents of the document, and if any criterion matches the one you specify in the 
Tweak Word dialog, Office Toys gives you the option to print or fax the document.
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AutoMail
AutoMail detects email documents and lets you automatically mail them rather than send them to 
your printer. Before sending the document to a printer, Office Toys looks at the template name, 
filename and contents of the document, and if any criterion matches the one you specify in the Tweak
Word dialog, Office Toys gives you the option to print the document, or send it to your email 
application.

AutoProof
AutoProof helps you to avoid printing, faxing or mailing documents with spelling or grammatical 
errors. You can set up your preferences and enable/disable this feature on the AutoProof tab of the 
Office Toys “Tweak Word” application (available on the Toys menu).
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Printing: Fine Print
In conjunction with Single Track Software (http://www.singletrack.com/), Office Toys offers you the 
most sensational printer driver ever. Fine Print is the perfect companion for all Office and other 
Windows software. Now you can print up to eight pages on a single sheet of paper, without sacrificing
legibility. 

Fine Print Highlights. 
 Print 1, 2, 4 or 8 pages on a single page, saving paper and printer toner.
 Create multiple stationary formats to print headers, footers, page numbers, date and time stamps.
 Add Watermarks (Confidential, Draft, etc.) to a page.
 Use all standard Windows print options, including fonts, graphics, page size, etc.
 Use any Windows 3.1x or Windows 95 (not Windows NT!) printer: inkjet, non-postscript laser, and

PostScript laser.

Smarter than others
Unlike other Office add-ons, Fine Print does not reformat your documents and is not restricted to 
PostScript printers. With Fine Print you can print any multi-page document (reports, worksheets, 
databases, presentations, web pages, software source code, etc.) to any printer, even to your fax 
driver! Fine Print works with all Windows 3.1x and Windows 95 (and soon with Windows NT) printers, 
and prints to any standard size of paper.

With Fine Print you can save significant amounts of paper and toner, and extend the life of your 
printer. According to paper and energy industry analysts, an administrative office employee uses 
approx. $500 worth of paper, energy, printer wear, and toner every year. Minimal use of Fine Print 
can save at least $200 per employee per year, whilst benefiting the environment.  

Start saving right away. 
If you download and register the special Office Toys edition (http://www.officetoys.com/fineprt.zip), 
Single Track Software gives you a 25 percent discount on the registration fee: you pay just $14.95 
instead of $19.95. The shareware version prints an "unregistered" message on each page, and is 
limited to 10 pages per print job. After you have registered your copy, both limitations are removed. 
Registration information is included in the download file.
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Formatting:
the Style menu

Many die-hard users of styles are far from happy with the way Word 97 displays its style list on the 
Formatting toolbar. It’s slow, inflexible, and the style preview doesn’t give any useful information. 
That’s why Office Toys comes with a revolutionary replacement that’s bound to become a classic. 
The Office Toys Style menu is on the Formatting toolbar, immediately to the left of Word’s own style 
list. Press ALT+S to open the menu.

What does the Style menu do?
1. It categorizes the available styles in distinct groups, so you don’t’ have to browse through a long 

list to find a heading, character or bullet style
2. It gives you not only the names of the styles, but also a full description of the associated format. 
3. It lets you create a private “Favorites” category that lists only the styles you use often.
4. It lets you quickly create both paragraph and character styles without displaying any dialog boxes.
5. It offers many options to modify, synchronize or otherwise manage styles.

Creating your menu of Favorite Styles
With Office Toys you can quickly create a list of styles you use often, which makes it even easier to 
format your documents. Simply place the cursor on text in your document that is formatted with a 
style you want to add to your Favorites. Then and click “Favorites” on the Style menu. If the style isn’t 
in the list yet, choose “Add to Favorites”. From now on this style is on the list. 

Automatically creating favorite styles
You can also automate the process of creating a list of Favorite styles. Open the Style/Favorites 
menu and select “Auto-add to Favorites”. When activated (which is the default setting), Office Toys 
automatically adds each new style you apply to the list of favorites. 

Removing favorite styles
To remove a style from the Favorites list, open the Style/Favorites menu, hold down the SHIFT key 
and select the style you want to remove.

Hiding or showing Style descriptions
By default, style names are listed with their description, so you can quickly see which formats are 
included in the style. If you don’t need to see these descriptions, select “Hide style descriptions”. You 
can at any time override this setting by holding down the following key while you click the Style menu:
 SHIFT: show full description
 CTRL: hide description

Creating a new style
Although Word lets you easily create a new paragraph style based on the current selection, there’s no
quick option to create a new character style. That’s why Office Toys offers this option on the Style 
menu. Select the type of style you want to create, select Style/New, type a name for the style and 
press ENTER. 

Customizing the Style menu
The third option on the Style menu lists all styles that are not built-in Word styles. If the current 
document is based on the Normal template, the caption is labeled “Private”. If the current document is
based on a different template, the caption holds the name of the template. 

You can customize this menu of custom styles by following the procedure described below:
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1. Open the template which holds the custom styles.
2. Choose Properties from the File menu
3. Select the Custom tab
4. In the “Name” box, type "StyleButton" (without the quotation marks)
5. In the “Type” list, select “Text”
6. In the “Value” box, type the name you want to appear on the menu that holds the custom styles. 

Try to keep the name as short as possible!
7. Click OK to confirm the settings
8. Save and close the template
9. From now on, whenever a user works on a document based on this template, the text specified in

Step 6 is automatically the caption on the custom styles menu.

We’ve created this option specifically for authors of add-in templates that mostly rely on styles.  For 
instance, if you're a publisher of a template for writers of screen plays, and your product is called 
“PlayWright” you can assign the “PlayWright “ caption to the third option on the Style menu.

Managing styles
The last item on the Style menu offers a range of options to manage your styles.

Style…
This displays Word’s own Style dialog box, in which you can create, delete and modify styles.

Redefine current style
This lets you redefine the format of the active style, using the formatting of the current selection. You 
are prompted to confirm this action.

Synchronize styles 
If you have modified style formats in the current document, you have two options to synchronize the 
styles in the document with the ones in the attached template. 
 Select “Import template styles…” to make the styles in the document match the ones in the 

attached template. This effectively reformats your document.
 Select “Export document styles…” to make the styles in the attached template match the ones 

in the document. This modifies the template, and has the effect that future documents based on 
that template will have the style formats used in the current document.

Neither action can be undone, so you are prompted to confirm the operation.

Remove Manual Formats
The options on this menu allow you to clean up a document or selection by removing formats that are
not part of the applied style. If text is selected in the document, the actions apply to the selected 
paragraphs, if no text is selected, they apply to the entire document.
 Reset Font to style: removes font formats that are not included in the paragraph style 

(equivalent to pressing CTRL+SHIFT+Z or CTRL+SPACEBAR)
 Reset Paragraph to style: removes paragraph formats that are not included in the paragraph 

style
 Remove manual Tab stops: removes all custom tab stops 

Delete unused styles
When you create a new document, Word usually copies all styles from the attached template to the 
document, even though you may not use all of them. This makes the list of styles that are in use 
unnecessarily long. With this option you can remove these unused styles from the document. In 
practice, however, you will notice that Word still leaves some unused styles (especially heading 
styles) in the document.
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Style Gallery
This option displays the Style Gallery dialog box, from which you can attach a different template to 
the active document.

Organizer
This option displays the Organizer dialog box, with the Styles tab selected. On this tab you can 
rename and delete styles, and copy styles from one template or document to another.
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Formatting: Finetuner and 
other formatting enhancements

Format Finetuner
Finetuner is the ultimate interactive font and paragraph formatter. Now you can adjust any selected 
text to fit the available space, or to create special effects, and see the result immediately. Finetuner 
can adjust fontsizes, character spacing, character scaling, character positioning, line spacing and 
paragraph indents in any increment. You can start Finetuner from the Toys menu. 

On what range does Finetuner work?
Before you start Finetuner, you can either make a selection, or reduce the selection to an insertion 
point. If no selection is made, fine-tuning of character formats is applied to only the word that holds 
the insertion point, otherwise Finetuner adjust the character formats in the selection. Paragraph fine-
tuning is applied to either the paragraph that holds the insertion point or selection, or to all paragraphs
that are selected.

Fine-tuning formats
Click a button to select the type of format that you want to fine-tune. While Finetuner is active, you 
can at any time select a different format, and “play” until you’re satisfied with the results. The black 
bar below the slider tells you which format and value are currently active. Move the slider, or click the 
buttons at the end of the slider to increase or decrease the format. 
By default, the slider’s range is limited to the most common minimum and maximum format values. 
To use the maximum available range, check the “Maximize slider range” button. For example: the 
default range of the fontsize slider goes from 4 to 100 pts, but if the range is maximized, you can fine-
tune the fontsize from 1 to 1637 pts.

Resetting a format
Click the “Reset original value” button to undo the changes you’ve made with the slider, and return 
the selected document text to its original state.

Refreshing screen updating
Sometimes you may notice that Word doesn’t update the screen while you adjust formats with the 
slider. That’s a bug in Word. In that case try clicking the “Refresh document view” button to see if that 
updates the display.

Adjusting font and paragraph formats without leaving Finetuner
While the Finetuner dialog box is displayed, you can click the “Display Font format dialog box” or 
“Display Paragraph format dialog box”  button to make format adjustments that are not covered by 
Finetuner. For example: you can use this feature to quickly change the font or the paragraph 
alignment of the selection, and then continue to use the slider.

Quick Font, Quick Paragraph
Office Toys adds two new options on the Format menu: Quick Font and Quick Paragraph. These 
options give you one-click access to the most common font formatting features, without opening the 
Font or Paragraph dialog box.

Copy and Paste format
Two handy-dandy buttons on the Office Toys toolbar that let you copy the format of the current text to
any other text. Unlike with Word’s Format Painter button you can paste the copied format to many 
other text parts, even in different documents!
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Creating Fancy Envelopes with
Envelope Manager (BETA)

Important note:
The current version of Envelope Manager is a beta release. As with all beta software, it may contain 
bugs. It’s also important to know that this is the first time Word lets you add graphics to envelopes, so
the technique is new, and may not be stable under all circumstances. We advise you to save your 
work before you create envelopes with Envelope Manager.

Graphic Envelopes – at last!
Word has always been able to create envelopes, but with Word 97 you can now for the first time use 
graphics on envelopes. Unfortunately, the feature is poorly documented, and Word doesn’t provide an
interface to manage envelopes. That’s why we’ve added an Envelope Manager to Office Toys.
Unlike other Word add-ins, Office Toys doesn’t create a proprietary envelope format which is pasted 
at the end of your letter, but generates “true” envelopes, which appear as page number 0 (zero) at the
start of your document. This also means that you don’t have to worry about the best way to print your 
envelope – Word takes care of that. The other good news is that Office Toys doesn’t use complex 
dialog boxes, but lets you select all options from a friendly popup menu. The only dialog box you’ll 
ever use is the one that’s built in Word itself!

What does Envelope Manager do?
The Office Toys Envelope Manager (some people may want to call it TOYveloper…)  gives you the 
following exciting features:

Add Envelope Art
Add logos, slogans and notes to your envelope, using Word’s own graphical tools, such as WordArt, 
AutoShapes, clipart, photos, scanned objects, frames, textboxes, etc.

Save and reuse Envelopes
Create as many envelopes as you like, in different sizes and with different graphics, and save them 
for later use. 

Swap Envelopes while you work
Add envelopes to any letter, change their design on the fly, resize envelopes while you work. 

Add any delivery or return address
Pick your delivery address from the address book of your choice, and use the return address of any 
user you have defined with Office Toys User Manager. Or generate great looking mail merge 
envelopes from any envelope you’ve designed.

Envelope Art basics

Language limitations
Office Toys Envelope Manager uses two predefined AutoText entries to add graphics to your 
envelopes. In the English version of Word these AutoText entries have the names EnvelopeExtra1 
and EnvelopeExtra2, in the French version EnveloppeExtra1 and EnveloppeExtra2, in the German
version BriefumschlagExtra1 and BriefumschlagExtra2 Since at this moment we don’t know these 
terms in other language versions of Word, Envelope Manager can currently only be used with 
English, German and French Word.
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How Word adds Envelope Art to your envelope
When you add an envelope to a document, or when you create a mail merge envelope, Word looks in
the current list of AutoText entries to see if one or both of the default entries exist. If they are found, 
Word automatically “pastes” them onto the envelope. If you create multiple envelope designs, Office 
Toys Envelope Manager makes sure that the associated AutoText entries are copied to the template 
on which the active document is based, so that Word can use the correct graphics.

How Office Toys saves your envelopes
After you’ve created an envelope, Office Toys can save it as a template, so you can reuse the same 
envelope for future documents. Envelopes are saved in special template files with the .ENV extension,
in the Envelopes subfolder of the main Toys folder. Each envelope template holds the saved 
graphics, plus a large amount of technical data, such as the envelope size, the placement and style of
the addresses, barcode settings, the printer feed method, etc. It is not recommended to make any 
manual changes to these envelope templates. 

The importance of “locking” Envelope Art
When you add graphics to an envelope, it is important that their location is locked in the proper way. 
This means that the position of each graphical element must be positioned relative to the top and left 
side of the page. If the graphic is positioned relative to a paragraph or margin, Word is likely to paste 
it in the wrong place when the envelope is created and printed. Office Toys checks to see if the 
position is correct, but this method is not failsafe, so it’s important that you verify this yourself.

Creating an envelope in 10 easy steps
If you want to design and save an envelope for later use, follow the steps shown below When we 
refer to the Envelope Manager menu,  we’re talking about the “Envelope Manager” option, just below 
the Envelopes and Labels command on the Tools menu.

1. Create a blank envelope
Open the Envelope Manager menu, click “Attach Envelope”, then select “Blank Envelope”. This adds 
a blank envelope at the top of your document.

2. Select the correct envelope size
If the default envelope doesn’t have the size you want to use, open the Envelope Manager menu, 
click “Envelope size”, then select the required envelope size. If the size you want isn’t on the list, 
select “Custom size” to display a dialog box in which you can specify the width and height of the 
envelope.

3. Insert the delivery and return address 
Although you can insert addresses at any stage in the process, it’s recommended to add both a 
(dummy) delivery and return address before you continue. 

 To add a return address, open the Envelope Manager menu, click “Return address”, then select one 
of the options. If you have used the Office Toys User Manager, the menu list the names of all users. 
Select a user to insert the associated address. If you want to create an envelope in which the return 
address is part of the artwork, select “Omit return address”.

 To add a delivery address, open the Envelope Manager menu, click “Delivery address”, then select 
one of the options.

4. Format the delivery and return address 
When Word inserts a delivery and return address, it uses the last default address formats and 
locations. Open Word’s “Envelopes and Labels” dialog box, and click the Options button. Select the 
“Envelope Options” tab, and modify the Return address and Delivery address options as required. 
Click OK to confirm your settings, then click “Change document” to apply the settings to your 
envelope. Now you’re ready to add your Envelope art!

5. Add your artwork
First make sure that the envelope is entirely visible. Switch to Page Layout view, and select a zoom 
factor that displays the entire envelope. Then open the Envelope Manager menu, and click “Envelope
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Art”. Select “Insert” to open a list of tools and objects you can use add graphics to your envelope. If 
you have copied an image from another application to the Clipboard, select “Paste Clipboard Graphic 
– Floating over Text” to add it to the document. If you select “Text box”, you can type any text in the 
box, and format the font, borders, and background as you please. You can resize the object, using 
the “size handles” that are placed around it.
Since Word lets you add two different graphical objects to an envelope, you can repeat these steps to
add a second object if required.

6. Position your artwork
Graphics, frames and textboxes are by default positioned as “floating over text”. You can move the 
object to the location where you want it to be printed, making sure that it doesn’t stand in the way of 
the return and delivery address. Then right-click on the graphic (or on the border of a frame or 
textbox), and select the option that lets you format the object. If the object is a frame, select the 
options that let you position both the horizontal and vertical position relative to the page. Otherwise, 
select the “Position” tab, and also specify both the horizontal and vertical position relative to the page.

7. Lock your artwork
Once your Envelope art has the right size and position, open the Envelope Manager menu, click 
“Envelope Art”, then select “Lock Selected Art as…”. The menu offers two options: Logo and Slogan. 
These names don’t have a specific meaning, but are used to make it easier for you to distinguish 
between the two graphical items you can add to an envelope. If the options are not available, it 
means that you didn’t select the object properly. In the case of a frame or textbox, always make sure 
that you select the border, not the contents of the object. When you select either Logo or Slogan, 
Office Toys creates the required AutoText entry.

9. Save your envelope
Before you do anything else, you should save the envelope you just created. Open the Envelope 
Manager menu, and click “Save Envelope as…” In the dialog box, type a name and click OK. When 
you choose a name, make sure it’s as descriptive as possible, e.g. “Private envelope Size 12”, or 
“Donna’s Envelope with the Funny Faces”.

10. Test your envelope
This is the moment of truth. You have created an envelope, with the right size, the right address 
formats, and the graphics correctly locked. Now open Word’s Envelopes and Labels dialog box, click 
Options, and select the “Printing Options” tab. Verify that the correct print feeding options are 
selected and click OK. Then click “Change document” to apply the settings to your envelope.
Now, feed an envelope to your printer and open the Envelope Manager menu. Select “Print”,  then 
“Envelope”, and then the target printer. 
If all is well, your envelope should be printed the way you designed it.

Removing envelope art
In most cases you cannot remove art from an envelope by simply deleting it. You will often see that 
Word refuses to accept the deletion. To remove artwork, open the Envelope Manager menu, select 
“Envelope Art”, then “Unlock/Remove Art”, and specify which item you want to remove. If you don’t 
remember which object is locked as Logo and which one as Slogan, choose “Find Art” to locate it.

Changing addresses
You can at any time select the delivery or return address from the Envelope Manager menu. Both 
addresses can be extracted from your Outlook or other address book, or can be imported from your 
list of AutoText entries. The return address can be the address of any user you have defined with the 
Office Toys User Manager. 
When you attach an envelope to a letter that already has an address, Office Toys will try to copy that 
address to the envelope. If the address in the letter is marked with the EnvelopeAddress bookmark, 
Office Toys will use that part of the document as the delivery address.
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Envelope Design Hints

Designing an envelope series
If you want to create a series of envelopes with different envelope sizes, but with a similar design, 
start out by designing the smallest envelope. Once you have designed and saved the first envelope, 
open the Envelope Manager menu, select “Envelope Size” and select the next size up. Now you can 
just move the addresses and lock the Envelope art in its new location and save the envelope under a 
new name. Continue this way until you have designed and saved the largest envelope in the series.

Adding more than two graphics
Although Word lets you only add two graphic objects to an envelope, you can easily create a single 
object that holds multiple graphics. First add a frame or textbox to the envelope, and format its 
horizontal and vertical position relative to the page. Then place the insertion point inside the frame or 
textbox, and insert a Word table with the required number of rows and columns. Now you can add 
graphics in every single cell of the table. Use the Borders and Shading command to add or remove 
borders, color and/or patterns. When you lock the frame or textbox, everything that’s inside it 
becomes part of the Envelope art.

Including the return address in a graphic
You can create Envelope art that holds the return address. The address can be a graphical logo, or 
you can include it as part of a table which you include inside a frame or textbox. When you include 
the return address in your Envelope art, make sure to select the “Omit return address” option.

Attaching and swapping saved envelopes 
Once you have created and saved a number of envelopes, you can at any time use them in your 
documents. Open the Envelope Manager menu and select the first option. If the current document 
doesn’t have an envelope, you can attach any envelope that’s on the list. If there is already an 
envelope in the document, you can use the same method to quickly replace the envelope with any 
saved envelope.

Attaching an envelope without graphics
Open the Envelope Manager menu and select the first option. In the dropdown menu, select “Blank 
Envelope” to attach an envelope without graphics. 

Editing a saved envelope 
To make design changes to an envelope that you’ve saved before, open the Envelope Manager 
menu, choose “Edit envelope” and select the envelope from the list. This creates a new blank 
document, with the selected envelope attached to it. Make the design changes, then open the 
Envelope Manager menu, and click “Save Envelope as…” In the dialog box, type a name and click 
OK.

Modifying an envelope that’s attached to a document
If the active document has an envelope, you can use all design features of Envelope Manager to 
make modifications. When done, open the Envelope Manager menu, and click “Save Envelope as…” 
In the dialog box, type a name and click OK.

Creating mailmerge envelopes
Creating a graphical mailmerge envelope is just as easy as attaching an envelope to a document. 
Open the Envelope Manager menu, choose “New Mailmerge envelope” and select an envelope from 
the list. Office Toys creates a blank document, with the selected envelope attached to it, and starts 
Word’s Mail Merge Helper. Follow the online instructions to create the main document and attach the 
data source.
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Printing options
You can print either the envelope or the letter, or both. Open the Envelope Manager menu, choose 
“Print” and select your options. If the current document is a mailmerge envelope, you can either print 
the first envelope as a test, or all envelopes.

Deleting an envelope from a document
If you don’t want to save the envelope with the document, or if you want to create a new envelope 
from scratch, .open the Envelope Manager menu, and choose “Delete envelope”. You are prompted 
to confirm the operation.

Refreshing an envelope
The “Refresh Envelope” option on the Envelope Manager menu is handy if you’ve made many 
changes to an envelope, and things look messy. This option deletes the current envelope (but not the
rest of the document), and immediately recreates a new envelope based on the last saved settings.

Updating Word’s default envelope settings
If you have multiple documents open with different envelopes, you cannot switch between documents
without confusing Word. Before you do anything with the envelope that you’ve just activated, open the
Envelope Manager menu, and choose “Update Envelope defaults”. Office Toys will then copy the 
Envelope art and address styles from the envelope template to the document template, and update 
the technical settings of the envelope. 

Supplied Sample Envelopes
Office Toys comes with three sample envelopes that you can use as a basis for your own envelopes. 
Attach them to a document, and study them to see how they were created.

Cartoons. Custom size 11”x11”

Envelope art consists of a single 
textbox which holds a table with a 
return address and six clipart items. 
The “Omit return address” box is 
checked.

Lightning. Size C5

Envelope art consists of a photo from
the Office CD, and a super-imposed 
WordArt object.

AirMail. Size 12

Envelope art consists of two 
textboxes, each with different 
shading and border formats
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Selecting and Editing
Office Toys offers many features that make it easier to select parts of your documents, and to edit 
your work. You will find most of them on the Edit and Insert menu.

Clear Undo List (Edit menu)
Word’s multiple Undo feature is great, but after many edits in your document, the Undo list becomes 
nearly impossible to navigate. If you’re happy enough with the state of the current document and want
to start with a clean Undo list, simply select “Clear Undo List” from the Edit menu. You are prompted 
to confirm the operation.

Paste Picture inline (Edit menu)
One of the features that got lost in Word 97 is the option to paste graphics from the Clipboard “inline”,
i.e. at the insertion point. Instead, Word now pastes pictures “floating” over the text. Office Toys gives 
you the old feature back as an additional option on the Edit menu. One of the unique advantages of 
pasting pictures inline is that you can use Word’s “auto-size” feature when pasting pictures in tables. 
To try this out, copy a picture to the Clipboard, create a table, place the insertion point in a cell, and 
select “Paste Picture inline”. You’ll see that the size of the picture is automatically adjusted to fit the 
width or height of the cell.

Clear Special… (Edit menu)
Excel 97 has a nice feature that lets you quickly clear formats and comments from a selection. Now, 
with Office Toys, Word has it too – and more! Select the part of the document (or make no selection 
to apply the action to the entire document) from which you want to remove bookmarks, comments, 
footnotes, endnotes, revision marks, custom tabs, or formatting that’s not part of a style. Then 
select “Clear Special…” from the Edit menu. The menu lists only items that are currently available. 
Select an item, and it’s done.

Select Current… (Edit menu)
Do you also have difficulty remembering the shortcuts to select a paragraph or sentence? Don’t you 
know how to select a page or section? Office Toys gives you all these features and more with a 
“Select current” option on the Edit menu. 
The options below the separator line are of a special kind: they let you select all text with the same 
format from the insertion point downward. E.g. to select all text formatted with the same font format as
the one under the cursor, simply choose Font on the menu.

Fast Find & Replace (Office Toys toolbar, CTRL+ALT+F4)
Unlike Word’s own Find dialog, the Office Toys Fast Find and Replace application is fast and 
interactive. 
To display the dialog box, click the “Fast Find and Replace” button on the Office Toys toolbar, or 
press CTRL+ALT+F4. The dialog immediately pops up with the text that’s currently selected. If there’s 
no selection, the current Word is highlighted and appears as your initial find criterion. If you’re looking 
for more occurrences of the same word, just click Find Next or press the ENTER key. If you’re looking 
for a different word, type it in the Find box. The moment you start entering text, the search starts, and 
in most cases you’ll notice that Office Toys has found the right word long before you finished typing it.
And if you’re looking for a word that doesn’t exist in the document, you’ll hear a beep before your 
typing is done and you know that your mission is hopeless. 
Fast Find and Replace doesn’t offer as many options as Word’s own dialog box, but the “Whole Word
only” and “Match Case” options are probably the only ones you use most often. The “Search” list 
offers the same options as Word’s own dialog, plus one extra. If you select “From Start”, the cursor is 
moved to the start of the document, and the search begins from there. 
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Replacing text
Fast Find and Replace can also replace text. Type the replacement text in the second box. Click Find
Next to search for each occurrence of the Find text, click Replace to replace it. To replace all 
occurrences, check the Replace All box and click Replace. 
If you’re looking for the same word in more than one document, there’s no need to close the dialog, 
switch document, and start again. Just open the “Document” list, select the document you want to 
search, and carry on finding and/or replacing.
Office Toys also offers the unique option to replace text in all currently open documents. To use this 
feature, check both the “Replace All” and “Replace in all documents” box before you click Replace.

Replacing multiple strings in more than one document
Fast Find and Replace doesn’t limit replacement actions to a single word. Click the Multi-Replace tab
to specify up to four different strings you want to replace at a time. By default, the action takes place 
in the active document, but you can select any other document in the “Replace in” list. Select the “All 
open documents” option to replace multiple strings in each document that’s currently open in Word.

Keyboard shortcuts:
You can use the following keys while you click the Fast Find & Replace button on the Office Toys 
toolbar to find the next or previous occurrence of the word under the cursor or the selected text, 
without displaying the dialog box.  If the word isn’t found, you’ll hear a beep:
CTRL: find next occurrence
CTRL+SHIFT: find previous occurrence

Jump to… (Toys menu)
Somehow we’ve never been very happy with Word’s GoTo and Bookmark dialog boxes. Word’s 
Object Browser at the bottom of the vertical scrollbar also has serious limitations. Wouldn’t you rather 
jump through a document on the basis of content rather than via cryptic bookmark names, 
meaningless footnote numbers and previous/next field commands? 
Of course. That’s why we added a “Jump to” option on the Edit menu which does just that. The 
following table tells you what the options are.

“Jump to” item The menu lists:
Bookmark The text associated with the bookmark. If the bookmark doesn’t contain 

text, the bookmark name is listed.
To list bookmark names rather than bookmark contents, hold down the 
SHIFT key while you open the Bookmark menu.

Field The field result. If the field doesn’t contain text, the field name is listed. To
list fied names rather than field results, hold down the SHIFT key while you
open the Field menu.

Hyperlink The name of the hyperlink. 
Comment The comment text. To list the names of the comments’ authors, hold 

down the SHIFT key while you open the Comment menu.
Footnote The footnote text.
Endnote The endnote text
Text Type the text you’re looking for and press ENTER.

Insert Accent (Office Toys toolbar, CTRL+. (PERIOD))
Forget those complicated keystrokes to insert accented letters or other special characters. Office 
Navigator gives you all options in a handy popup menu. 
Click the Insert Accent button on the Office Toys toolbar or press CTRL+. (the period key) to display 
the menu. Select a letter or category, then select the special version of it. Done! 
From the same menu you can also display Word’s Symbol dialog box, or start the Windows Character
Map application.
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Quick Field (Toys menu)
The Quick Field option is added to the Insert menu, and lets you quickly insert commonly used fields 
without displaying a dialog box.

Field Commands (Toys menu)
Do you often work with fields, but can’t remember the hotkeys for those special commands that lock, 
unlock, unlink, display and find fields? No problem: Office Toys adds a Field Commands option to the 
Toys menu, where each command is just a mouse-click away.

Quick Sort (Table menu)
Quick Sort is an additional option on the Table menu. If you want to sort selected text in ascending or 
descending order, you can do it now without displaying the Sort dialog box.

Other Table Tools (Table menu)
A new item at the bottom of the Table menu, which holds table features that Microsoft forgot to place 
on the menu.

A smarter Spike
Word’s Spike feature could have been a handy tool if it didn’t cut the selected text to the special 
“Spike” AutoText entry, but offered you the option to copy text to the Spike. Office Toys adds that 
feature to Word 97. 
Run the Tweak Word application (Toys menu), and select the Spike tab to set your preferences. 
When you use the standard keyboard shortcuts (CTRL+F3 to add the selection to the Spike, 
CTRL+SHIFT+F3 to insert the Spike contents at the insertion point), Office Toys intercepts these 
commands and applies your preferences.
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Editing: Favorite Symbols & Bullets 
New in this version! Office Toys Favorite Symbols & Bullets is the application that makes it easy to 
build a database of your most used special characters, and insert them as symbols, bullets or text 
anywhere in your documents. 

Running Favorite Symbols & Bullets 
Select Favorite Symbols from the Office Toys toolbar or the Toys menu. The Favorite Symbols & 
Bullets dialog box comes with 7 tabs, each holding 24 different special characters. All default symbols
are from the WingDings, Symbol and Marlett character sets, which are probably installed by default 
on your system. The preview box displays an enlarged version of the symbol under the mouse pointer
To insert a symbol or bullet, simply click the button. 
You can select one of three ways to insert a special character in the document:
¡ Insert as Symbol. Inserts the character in the Word symbol format. If you choose this option 

while text is selected, the symbol is pasted after the last selected character.
¡ Insert as Bullet. Pastes the character as a bullet in front of the current paragraph, or of all 

paragraphs that are selected. This option is automatically the default if text is selected.
¡ Insert as Text. Inserts the character as regular text, formatted in the associated font. Unlike 

symbols, this allows you to use search and replace operations, using the font of the character as 
a search criterion. If you choose this option while text is selected, the character is pasted after the
last selected character. 

Customizing Favorite Symbols & Bullets 
You can replace the symbol on any of the 168 buttons with a different symbol, or create different 
categories by renaming the text on the tab. 
¡ To replace a symbol, click on it with the right mouse button. This displays Word’s Symbol dialog 

box. Select a new symbol in any font and click the Insert button. The selected symbol 
immediately replaces the original one.

¡ To rename a tab, click on it with the right mouse button. This displays an inputbox in which you 
can type a new name. 

¡ To reset a tab to its original settings, click the Reset button.
¡ To adjust the size of the dialog box, click the zoom buttons. This increases or decreases the size 

by 5%, within a range of 50 – 200%. The selected zoom factor automatically becomes the default 
the next time the dialog box is displayed.
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Proofing 
Office Toys introduces four features that are a welcome addition to Word’s advanced set of proofing 
tools.

A Better Word… (Office Toys toolbar, SHIFT+F7)
Don’t you just love Word’s on-the-fly spell checker? And don’t you miss the same convenience for the
Thesaurus? Not anymore! Type a word, or place the cursor on a word for which you want a better 
alternative, press SHIFT+F7 or click the “A Better Word” icon on the Office Toys toolbar, and you see a
popup menu with synonyms. If a word has different meanings, you’ll see alternative words for each 
meaning. Click – and it’s inserted in your document. 

Add to… (Spelling shortcut menu)
Word’s instant spell checker is a godsend, but the right-click Spelling context menu doesn’t know that 
you may have more than one spelling dictionary. If you choose “Add”, the word is added to the 
dictionary that happens to be the default at that moment. That’s why we added an “Add to” command 
to the Spelling menu, from where you can select the dictionary to which you want to add a word that 
isn’t misspelled at all. You can even create a new dictionary on the fly and add the selected word to it!

Toggle Proofing (Tools menu)
If a document is set up for a certain language, Word’s proofing tools flag every error in the document. 
Most of the time that’s fine, but it can become very annoying if you write a document with a lot of 
technical jargon, or paragraphs in a language that’s not supported by Word, such as Latin, or 
medieval English. That’s why Office Toys adds a “Toggle Proofing” command to the Language 
submenu on the Tools menu. Now you can instantly disable all proofing tools (speller, grammar 
checker, hyphenator) for a selection, or for the text you type after the current insertion point. The 
“Toggle Proofing” menu is also smart enough to list only the languages for which you actually have 
proofing tools, so you don’t have to browse through the l-o-n-g languages list to re-enable proofing.

AutoProof (Tweak Word, Toys menu)
Office Toys AutoProof helps you to avoid printing, faxing or mailing documents with spelling or 
grammatical errors. You can set up your preferences and enable/disable this feature on the 
AutoProof tab of the Office Toys “Tweak Word” application (available on the Toys menu). 
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Viewing and organizing windows
Quick View (Toys menu)

No need to find your way through lots of menus and dialog boxes to set your viewing environment. In 
the Office Toys Quick View dialog box you can quickly set most options that define how your 
document is displayed.  It even lets you change your computer’s video mode on the fly! See “Quick 
Zoom” below for details about the options on the Zoom tab.

Quick Zoom (Office Toys toolbar)
The Quick Zoom dialog box is a subset of the Quick View dialog box in which you can interactively 
set the zoom factor for the current document, up to a single percent accuracy. If you have a 
document with many pages, you can use the “Columns” box to specify how many pages you want to 
display side-by-side. Type 0 (zero) to restore the Page Width zoom factor. Start Quick Zoom from the 
Office Toys toolbar. 

Shortcuts
Quick Zoom offers two additional options in combination with the SHIFT and CTRL key.
 Hold down the SHIFT key while you click the Quick Zoom button to decrease the zoom factor 5 

percent
 Hold down the CTRL key while you click the Quick Zoom button to increase the zoom factor 5 

percent

Change Video Resolution (Toys menu)
Zooming out of a document is cool, but sometimes you need more visible workspace. That’s why we 
added an option to the Toys menu that lets you instantly change the resolution of your screen without 
leaving Word. The menu only lists the video modes that are available without rebooting your 
computer.

Auto Scroll (View menu)
Do you have the new Microsoft IntelliMouse™? Then you can automatically scroll through your 
document at any speed you want. Select Auto Scroll from the View menu, and move the mouse 
pointer to the scroll bar. Move the mouse above the center to scroll up at increasing speeds, move it 
below the center to scroll down. Click the center of the scrollbar to stop Auto Scroll.

Organize All (Window menu)
A versatile alternative for Word’s Arrange All command on the Window menu. Click Organize All 
instead to rearrange all open windows in one of six different ways. 

Window Organizer (Window menu)
A powerful application that lets you select open windows or documents, and manipulate them in any 
imaginable way. The Window Organizer dialog box holds four tabs:

Windows tab
On this tab you can select the windows you want to arrange on your screen, hiding the other 
windows. The first five buttons let you decide how the windows must be arranged. With the last button
you can close the selected windows or panes.
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Panes tab
On this tab you can select an open document, create multiple panes for it, and arrange the panes in 
five different layouts. Once the panes are created, you can set the view, and edit the document 
contents in each pane. 

Tasks tab
On this tab you can arrange Word with another open application (e.g. Excel) for easy drag-and-drop 
operations. The first four buttons define how the second task is aligned with Word. With the fifth 
button you can activate a task and give it an “on top” status, which means that it will never be 
obscured by Word or another application. This can be handy for example if you want to have the 
Windows calculator available while you work. You can cancel the “on top” status by selecting the 
same application again on the Tasks tab, and clicking the last button.

Documents tab
This is a “bonus” tab, on which you can select any combination of currently open documents and 
execute a command that affects all selected documents. From left to right the options are: Save, 
Print, Route, Email, Add to Favorites, and Close.
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Managing information
Titlebar Info (Toys menu)

This option turns Word’s titlebar into an info center, and introduces the world’s first “live” wordcounter.
The options are:

Don’t change
Office Toys doesn’t change anything on the titlebar.

Full Pathname
The document’s full pathname is displayed on the titlebar. If the path or document name is very long, 
or the screen resolution is low, you may not see the entire information.

Document Statistics
The titlebar shows the document name, followed by information about the number of pages, words, 
characters, paragraphs and lines in the document. If text is selected, the statistics apply to the 
selection. The information is automatically updated every 30 seconds, and also each time you save a 
document, or switch from one document to another.

Author name
The titlebar shows the document name, followed by the name of the person who wrote the document.

Inside Information (Toys menu)
This application lets you store information (“document variables” in Word jargon) in your document 
that remains invisible for the uninitiated. Ideal for saving scrap text, notes, etc. You can also save 
selected document text as Inside Info, or copy Inside Info into your document. Each block of Inside 
Info can be up to 62,000 characters long. Note: Inside Info is stored unformatted. 

Word Count Wizard (Toys menu)
The Office Toys Word Count Wizard adds new options to Word’s word counter. Now you can also get
word counts and readability statistics for the current page or section, or for the text up to or after the 
insertion point. You can even add your private statistical standards (such as French “Feuillets” or the 
American 500 words standard), or calculate the money you’re making with your document! 

Running Word Count Wizard
You can start the Word Count Wizard from the Toys menu. On the opening screen you can select the
part of the document over which you want to get statistics. You can bypass the opening screen, 
holding down the following buttons while you start the wizard:
 SHIFT: statistics over the entire document
 CTRL: statistics over the current page
 SHIFT+CTRL: statistics over the text between the start of the document and the current selection

Creating custom standards
The Word Count Wizard lets you create up to three custom statistical standards. Run the wizard and 
click Next until you see the Customize button. Click this button to display the customizing dialog box. 
Here you can specify how the custom statistic is calculated. 

Other Date (Insert menu)
Word’s Date and Time option on the Insert menu knows only one date: today. But what if you want to 
insert tomorrow’s or next Tuesday’s date in a document? Or the date that is exactly four weeks from 
now? That, and much more, is at your fingertips if you choose “Other date” from the Insert menu.
The “Other date” option expands to a number of cascading menus from where you can easily select a
date that matches what you’re looking for. At the end you see a menu of date information in seven 
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different formats, which you can insert in the document. As a bonus “Other date” tells you how many 
days are left until the magic first day of the next millennium.
The “Other Date” menu also offers the option to quickly set the system date or time.

Calculate (Tools menu)
It was a standard feature on the Tools menu in Word 2, but Microsoft dropped it in later versions. 
Office Toys brings it back to life. It works like this: type a mathematical formula in your text, e.g. 
125*20.7%+21*8. Then select the formula and select Tools Calculate from the Tools menu. The result
of the calculation (193.875) is displayed on the statusbar and automatically copied to the clipboard, 
so that you can paste the result in your document.

Out of Office (Office Toys toolbar)
Do you work in an office environment with colleagues or a secretary? Does it ever happen that you 
have to leave the office before you can tell anybody where you are and when you expect to be back? 
Forget those yellow sticky notes on your monitor and enter the electronic world! WordToys brings you
the computer assisted Out Of Office application, and optionally protects your computer from sneaky 
eyes!

Before you run this application, you need to know how it works. Out Of Office uses the Windows 
“Scrolling Marquee” screen saver to blank your screen and display your message. This screen saver 
is part of all Windows versions, so normally it should be installed on your system. The first time you 
run Out Of Office, it will try to find this screen saver. 

If the file can’t be found in your \WINDOWS or \WINDOWS\SYSTEM folder, you’ll be asked to locate it 
yourself. If that doesn’t work out, run the Windows Setup program, install the Scrolling Marquee 
screen saver, and try running Out Of Office again.

Open the Out Of Office dialog from the toolbar or menu. The inputbox always displays the last 
message you used, but you can type a new one if required. Click OK to start displaying your message
on your screen. 

If you’ve set up Windows to display a password when you run a screen saver, the same password is 
also used for Out Of Office. If you don’t have a password, type an asterisk (*) in the Out Of Office box 
to create one. Note that this password applies to all Windows screen savers, so you better not forget 
it! 

The scrolling message is displayed in the default format (font, fontsize, scrolling speed, etc.). To 
change these parameters, type an asterisk (*) in the Out Of Office box to set your preferences.
When you’re back in the office, just move your mouse or hit any key to disable the screen saver. Type
your password if required, and that’s it. Hope you had a good lunch!
Note: Although Out Of Office uses a screen saver, it does not make any changes in your Windows 
settings, so your original screen saver will continue to work if you don’t activate Out Of Office.

Shortcuts
 Hold down the CTRL key while you start Out Of Office to immediately redisplay your last message,

without further input.
 Hold down the SHIFT key while you start Out Of Office to run the default Windows screen saver.
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Customizing Word
IntelliSwitch (Toys menu)

Microsoft’s IntelliSense™ technology is a breakthrough in automation. But sometimes you’d quickly 
like to turn one of its features on or off. That’s why we added an IntelliSwitch option to the Toys menu.
It lists most AutoCorrect and AutoFormat options, and shows the status of each setting. To toggle a 
feature on or off, just click it. Since you may not want to change all IntelliSense settings on a regular 
basis, you can easily modify the menu to suit your needs. Click “Customize..”, and in the dialog box 
select or deselect the items you want on the menu.
TIP: you can at any time display the full list by holding down the SHIFT key while you select the 
IntelliSwitch menu.

Tweak Word (Toys menu)
The Tweak Word application offers many options to make Word behave the way you want it. Most of 
them are explained elsewhere in this documentation. The remaining options are on the “Word” tab.

Maximize Word at Startup
When enabled, Office Toys maximizes the Word application window when you start Word.

Animate Assistant when changing documents
If you like the Office Assistant to be more active while you work, check this box. When enabled, the 
Assistant will make random movements each time you open a document, or switch from one 
document to another.

Enable INS key to insert/overtype
The INS key in Word 97 doesn’t let you toggle between insert and overtype mode, like in previous 
Word versions. By checking this option you can re-enable this feature. If you enable this option, it 
becomes immediately active; if you disable it, the change will not be effective until you restart Word.

Suggestions are welcome!
There’s room for more customization features on the “Word” tab. If you have any suggestions, please 
let us know!
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